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Abstract 

 
  

These Application Notes describe the procedures for configuring Session Initiation Protocol 

(SIP) Trunking on an enterprise solution consisting of Avaya IP Office 11.0, to interoperate 

with the NexVortex SIP Trunking Service. 

 

The NexVortex SIP Trunking service provides customers with PSTN access via a SIP trunk 

between the enterprise and the service provider’s network, as an alternative to legacy analog or 

digital trunks. This approach generally results in lower costs for the enterprise. 
 

Readers should pay attention to Section 2, in particular the scope of testing as outlined in 

Section 2.1 as well as any observations noted in Section 2.2, to ensure that their own use 

cases are adequately covered by this scope and results. 
 

Information in these Application Notes has been obtained through DevConnect compliance 

testing and additional technical discussions. Testing was conducted via the DevConnect 

Program at the Avaya Solution and Interoperability Test Lab. 
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1. Introduction 
These Application Notes describe the procedures for configuring Session Initiation Protocol 

(SIP) Trunking on an Avaya IP Office 11.0 enterprise solution to interoperate with the 

NexVortex SIP Trunking service. 

 

In the sample configuration, the Avaya IP Office solution consists of an Avaya IP Office Server 

Edition Primary Server release 11.0, an Avaya IP Office 500 V2 Expansion System release 11.0 

and Avaya IP Office softclients and deskphones, including SIP, H.323, digital, and analog 

endpoints, listed in Section 4. 

 

The SIP trunking service provided by NexVortex referenced within these Application Notes is 

designed for business customers. Customers using this service with this Avaya enterprise 

solution are able to place and receive PSTN calls via a broadband WAN connection using the 

SIP protocol. This converged network solution is an alternative to traditional PSTN trunks such 

as analog and/or ISDN-PRI trunks.  

 

As a required component of the NexVortex SIP Trunking Service offering, a CPE Access Router 

is deployed by the service provider at the enterprise site (customer premises). NexVortex is 

responsible for performing the configuration and maintenance of the CPE Access Router, as 

required.  

 

Note that the terms “service provider” or “NexVortex” will be used interchangeably throughout 

these Application Notes. 
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2. General Test Approach and Test Results  
A simulated enterprise site containing all the Avaya equipment for the SIP-enabled solution was 

installed at the Avaya Solution and Interoperability Lab. The enterprise site was configured to 

connect to NexVortex SIP Trunking Services via a broadband connection.  

 

The configuration shown in Figure 1 was used to exercise the features and functionality tests 

listed in Section 2.1.   

 

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members.  The 

jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent 

to the interoperability of the tested products and their functionalities.  DevConnect Compliance 

Testing is not intended to substitute full product performance or feature testing performed by 

DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or 

completeness of a DevConnect member’s solution. 

 

Avaya recommends our customers implement Avaya solutions using appropriate security and 

encryption capabilities enabled by our products. The testing referenced in these DevConnect 

Application Notes included the enablement of supported encryption capabilities in the Avaya 

products.  Readers should consult the appropriate Avaya product documentation for further 

information regarding security and encryption capabilities supported by those Avaya products. 

Support for these security and encryption capabilities in any non-Avaya solution component is 

the responsibility of each individual vendor.  Readers should consult the appropriate vendor-

supplied product documentation for more information regarding those products.  

 

For the testing associated with this Application Notes, the interface between the Avaya systems 

and the NextVortex service did not include use of any specific encryption features as requested 

by NexVortex. Encryption (TLS/SRTP) was enabled between Avaya products internally on the 

enterprise. 
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2.1. Interoperability Compliance Testing 

To verify SIP trunking interoperability, the following features and functionality were covered 

during the interoperability compliance test:  

• Response to SIP OPTIONS queries. 

• Incoming PSTN calls to various phone types. Phone types included SIP, H.323, digital 

and analog telephones at the enterprise. All inbound PSTN calls were routed to the 

enterprise across the SIP trunk from the service provider. 

• Outgoing PSTN calls from various phone types. Phone types included SIP, H.323, 

digital, and analog telephones at the enterprise. All outbound PSTN calls were routed 

from the enterprise across the SIP trunk to the service provider. 

• Inbound and outbound PSTN calls to/from Avaya Equinox for Windows softphones. 

• Various call types including: local, long distance national, outbound toll free and local 

directory assistant (411). 

• Proper disconnect when the call is abandoned by the caller before it is answered. 

• Proper disconnect via normal call termination by the caller or the called parties. 

• Proper disconnect for calls that are not answered. 

• Proper response to busy endpoints. 

• Proper response/error treatment when dialing invalid numbers.  

• Proper codec negotiation and two-way speech path. Testing was performed using codec 

G.711MU. 

• Proper response to no matching codecs condition. 

• Caller ID presentation and Caller ID restriction.  

• DTMF transmission using RFC 2833. Voicemail navigation for inbound and outbound 

calls.  

• Calling number blocking (Privacy). 

• Call Hold/Resume (long and short duration). 

• Call Forward (unconditional, busy, no answer).  

• Blind Call Transfers. 

• Consultative Call Transfers. 

• Station Conference. 

• Mobility twinning of incoming calls to mobile phones. 

• Long duration calls. 

• Proper response/error treatment to all trunks busy conditions. 

• Proper response/error treatment for signaling failure conditions. 

 

Items not supported or not tested included the following: 

• 911 Emergency calls were not tested 

• Inbound toll-free calls were not tested. 

• Outbound international calls were not tested. 

• 0, 0+10 digits calls are not supported. 
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2.2. Test Results 

Interoperability testing of the NexVortex SIP Trunking service was completed with successful 

results for all test cases with the observation described below: 

 

• Neither T.38 nor G711 pass-through fax are supported by NexVortex on the SIP trunk.  

Fax should not be used in this solution. 

• REFER is not currently supported by NexVortex. Inbound or outbound PSTN calls that 

are transferred back to the PSTN complete successfully, but the IP Office remains in the 

path of the call after the transfer is completed, and two trunks remain busy for the entire 

duration of the call. 

2.3. Support 

For support on NexVortex offer visit the corporate Web page https://www.nexvortex.com/ 

 

Avaya customers may obtain documentation and support for Avaya products by visiting 

http://support.avaya.com. Alternatively, in the United States, (866) GO-AVAYA (866-462-8292) 

provides access to overall sales and service support menus. 

https://www.nexvortex.com/
http://support.avaya.com/
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3. Reference Configuration 
Figure 1 illustrates the test configuration used. The test configuration simulates an enterprise site 

with an Avaya IP solution connected to the NexVortex SIP Trunking service through the public 

Internet. 

 

 
 

Figure 1: Test Configuration 

 

Note that for confidentiality and privacy purposes, public IP addresses, domain names, and 

routable DID numbers used during the compliance testing have been masked. 
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As part of the reference configuration, a CPE Access Router is deployed by the service provider 

at the customer premises (enterprise site). NexVortex is responsible for the installation, initial 

configuration and maintenance of the CPE Access Router, as required.  

 

Avaya IP Office provides the voice communications services for the enterprise. In the reference 

configuration, Avaya IP Office runs on the Avaya IP Office Server Edition platform. Note that 

this solution is extensible to deployments using the standalone IP500 V2 platform as well.  

 

In the sample configuration, the Primary server runs the Avaya IP Office Server Edition Linux 

software. Avaya Voicemail Pro runs as a service on the Primary Server. The LAN1 port of the 

Primary Server is connected to the enterprise LAN. The LAN2 port was used to connect to the 

NexVortex CPE Access Router interface. 

 

The Expansion System (V2) is used for the support of digital, analog and additional IP stations. 

It consists of an Avaya IP Office 500v2 with analog and digital extension expansion modules, as 

well as a VCM64 (Voice Compression Module). The LAN1 port of the Avaya IP Office 

IP500V2 is connected to the enterprise LAN, while the LAN2 port was not used.  

 

IP endpoints at the enterprise include 96x1 Series IP Deskphones (with H.323 firmware), Avaya 

1100 and J100 Series IP Deskphones (with SIP firmware) and Avaya Equinox for Windows 

Softphones. Some IP endpoints were registered to the Primary Server while others were 

registered to the Expansion System. Avaya 9500 Digital Deskphones and analog telephones are 

connected to media modules on the Expansion System. The site also has a Windows PC running 

Avaya IP Office Manager to configure and administer the system. Mobile Twinning is 

configured for some of the IP Office users so that calls to these users’ extensions will also ring 

and can be answered at the configured mobile phones.  

 

The transport protocols on the SIP trunk between IP Office and NexVortex, across the public 

Internet, is UDP for signaling and RTP for media. The transport protocol between Avaya 

components inside the enterprise private IP network (LAN), is TLS for signaling and SRTP for 

media. 

 

During the compliance test, users dialed a short code of 9 + N digits to make outbound calls 

across the SIP trunk to NexVortex. The short code 9 was stripped off by IP Office but the 

remaining N digits were sent unaltered to the network. On inbound calls, NexVortex sent 11  

(1 + 10) digits number on the destination headers on inbound SIP INVITE messages. 

 

In an actual customer configuration, the enterprise site may include additional network 

components between the service provider and the IP Office system, such as a session border 

controller or data firewall. A complete discussion of the configuration of these devices is beyond 

the scope of these Application Notes. However, it should be noted that all SIP and RTP traffic 

between the service provider and the IP Office system must be allowed to pass through these 

devices. 
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4. Equipment and Software Validated 
The following equipment and software were used for the sample configuration provided: 

 

Equipment/Software Release/Version 

Avaya 

Avaya IP Office Server Edition 

Avaya IP Office Voicemail Pro 

Release 11.0.4.0.0 Build 74 

Release 11.0.4.0.0 Build 5 

Avaya IP Office 500 V2 Expansion System Release 11.0.4.0.0 Build 74 

Avaya IP Office Manager Release 11.0.4.0.0 Build 74 

Avaya 96x1 Series IP Deskphone (H.323) Release 6.8002 

Avaya 1140E IP Deskphone (SIP) Release 04.04.23.00 

Avaya J169 IP Deskphone (SIP) Release 3.0.0.2.2  

Avaya 9508 Digital Deskphone Release 0.60 

Avaya Equinox for Windows Release 3.5.5.113.24 

Avaya 6211 Analog Telephone - 

NexVortex 

Netvanta 3140 (CPE Access Router) Firmware 13.2.3 

 

Table 1: Equipment and Software Versions 

 

Note – Compliance Testing is applicable when the tested solution is deployed with a standalone IP 

Office 500 V2, and also when deployed with all configurations of IP Office Server Edition. IP Office 

Server Edition requires an Expansion IP Office 500 V2 to support analog or digital endpoints or 

trunks. 
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5. Avaya IP Office Primary Server Configuration 
Avaya IP Office is configured through the Avaya IP Office Manager application. From the PC 

running the IP Office Manager application, select Start →  Programs → IP Office → Manager 

to launch the Manager application. Log in using the appropriate credentials. 

 

 
 
On Server Edition systems, the Solution View screen will appear, similar to the one shown below. 

All the Avaya IP Office configurable components are shown in the left pane, known as the 

Navigation Pane. Clicking the “plus” sign next to the Primary server system name, e.g., IPOSE-

Primary, on the navigation pane will expand the menu on this server. 
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In the screens presented in the following sections, the View menu was configured to show the 

Navigation pane on the left side, the Group pane in the center and the Details pane on the right 

side. These panes will be referenced throughout the rest of this document.  

 

Standard feature configurations that are not directly related to the interfacing with the service 

provider are assumed to be already in place, and they are not part of these Application Notes. 

5.1. Licensing  

The configuration and features described in these Application Notes require the IP Office system 

to be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity, 

contact an authorized Avaya sales representative. 

 

In the reference configuration, IPOSE-Primary was used as the system name of the Primary 

Server and IP500 Expansion was used as the system name of the Expansion System. All 

navigation described in the following sections (e.g., License) appears as submenus underneath 

the system name in the Navigation Pane.  

 

Navigate to License in the Navigation Pane. In the Details Pane verify that the License Status 

for SIP Trunk Channels is Valid and that the number of Instances is sufficient to support the 

number of channels provisioned for the SIP trunk. 
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On Server Edition systems, the number of licenses to be assigned to the specific Server or 

Expansion System is reserved from the total pool of licenses present on the license server. On the 

screen below, 10 SIP Trunk Sessions licenses were reserved to be used by the Primary Server. 

 

 

5.2. System Settings  

This section illustrates the configuration of system settings. Select System on the Navigation 

pane to configure these settings. The subsection order corresponds to a left to right navigation of 

the tabs in the Details pane for System settings. For all the following configuration sections, the 

OK button (not shown) must be selected in order for any changes to be saved. 

5.2.1. LAN1 Tab 

In the sample configuration, LAN1 is used to connect the Primary Server to the enterprise private 

network. 

5.2.1.1 LAN1 – LAN Settings Tab 

To view or configure the LAN 1 IP address and subnet mask, select the LAN1 → LAN Settings 

tab and enter the information as needed, in accord to the customer specific requirements: 

• IP Address: 10.64.19.170 was used in the reference configuration. 

• IP Mask: 255.255.255.0 was used in the reference configuration. 

• Click the OK button (not shown). 
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5.2.1.2 LAN1 VoIP Tab   

Select the LAN1 → VoIP tab as shown in the following screen. The following settings were 

used in the reference configuration:  

• The H323 Gatekeeper Enable box is checked to allow the use of Avaya IP Telephones 

using the H.323 protocol, such as the Avaya 96x1-Series Deskphones used in the 

reference configuration.  

• The H.323 Signaling over TLS should be set based on customer needs. In the reference 

configuration it was set to Preferred.  

• The SIP Registrar Enable box was checked to allow Avaya J100-Series Deskphones, 

Avaya 1100-Series Deskphones and Avaya Equinox usage.  

• The Domain Name and SIP Registrar FQDN used in the reference configuration was 

silipose.customer.com.  

• Set the Layer 4 Protocol section based on customer needs. In the reference configuration 

TCP/5055 and TLS/5056 were configured.  

• Other fields were left at their default values.  

• Click the OK button (not shown).  
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5.2.1.3 LAN1 - Network Topology Tab  

Select the LAN1 → Network Topology tab as shown in the following screen, and enter the 

following:  

• Public IP Address: The 0.0.0.0 default value was used. This means Avaya IP Office will 

use the LAN1 IP address specified on the LAN1 LAN Settings tab described above 

(10.64.19.170).  

• Firewall/NAT Type was set to Unknown in the reference configuration.  

• Click the OK button (not shown).  
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5.2.2. LAN2 Tab 

In the sample configuration, the LAN2 interface is used for the SIP trunk connection to 

NexVortex. 

5.2.2.1 LAN2 - LAN Settings Tab 

To view or configure the LAN2 IP address and subnet mask, select the LAN2→ LAN Settings 

tab, and enter the information as needed, according to the customer network requirements: 

 

• IP Address: 192.168.80.23 was used in the reference configuration.  

• IP Mask: 255.255.255.128 was used in the reference configuration. 

• Other parameters on this screen are set to the defaults.  

 

 

5.2.2.2 LAN2 - VoIP Tab  

Select the LAN2 → VoIP tab in the Details Pane. Check the SIP Trunks Enable box to allow 

the configuration of SIP trunks. Since no SIP endpoints are to register on this interface, leave the 

SIP Registrar Enable box unchecked.  
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Scroll down the page: 

• Verify the RTP Port Number Range. Based on this setting, Avaya IP Office will 

request RTP media to be sent to a UDP port in the configurable range for calls using 

LAN2. The Minimum and Maximum port numbers were kept at their default values in 

the reference configuration. 

• In the Keepalives section, set the Scope to RTP-RTCP. Set the Periodic timeout to 30 

and the Initial keepalives parameter to Enabled. This is done to prevent possible issues 

with network firewalls closing idle RTP channels.  

• In the DiffServ Settings section, IP Office can be configured to mark the Differentiated 

Services Code Point (DSCP) in the IP Header with specific values to support Quality of 

Services (QoS) policies for both signaling and media. The DSCP field is the value used 

for media, while the SIG DSCP is the value used for signaling. These settings should be 

set according to the customer’s QoS policies in place. The default values used during the 

compliance test are shown. 

• Click OK to commit (not shown). 
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5.2.2.3 LAN2 - Network Topology Tab  

On the LAN2 Network Topology tab in the Details pane, set the following: 

• Select the Firewall/NAT Type from the pull-down menu to Open Internet. With this 

configuration, the STUN Server IP Address and STUN Port are not used.  

• Set Binding Refresh Time (seconds) to 180. This value is used to determine the 

frequency at which Avaya IP Office will send SIP OPTIONS messages to the service 

provider.  

• Set Public Port to 5060.   

• Default values were used for all other parameters. 

• Click the OK button (not shown). 
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5.2.3. Telephony Tab 

To view or change telephony settings, select the Telephony tab and Telephony sub-tab as 

shown in the following screen. The settings presented here simply illustrate the values used in 

the reference configuration and are not intended to be prescriptive.  

• Uncheck the Inhibit Off-Switch Forward/Transfer box to allow call forwarding and 

call transfers to the PSTN via the SIP trunk to the service provider. If for security reasons 

incoming calls should not be allowed to transfer back to the PSTN, then leave this setting 

checked. 

• Set the Companding Law parameters to U-Law as is typical in North America.  

• Default values are used in the other fields.  

• Click the OK button (not shown).  
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5.2.4. VoIP Tab 

Navigate to the VoIP tab in the Details pane to view or change the system codecs and VoIP 

security settings. 

5.2.4.1 VoIP - VoIP Tab 

Select the VoIP → VoIP tab. Configure the following parameters: 

• The RFC2833 Default Payload field allows for the manual configuration of the payload 

type used on SIP calls that are initiated by the IP Office. The default value 101 was used. 

• For codec selection, select the codecs and codec order of preference on the right, under 

the Selected column. The Default Codec Selection area enables the codec preference 

order to be configured on a system-wide basis. The buttons between the two lists can be 

used to move codecs between the Unused and Selected lists, and to change the order of 

the codecs in the Selected codecs list. By default, all IP lines and phones (SIP and H.323) 

will use the system default codec selection shown here, unless configured otherwise for a 

specific line or extension. The example below shows the codecs used for IP phones (SIP 

and H.323), the system’s default codecs and order were used. 

• Click OK to commit (not shown). 
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5.2.4.2 VoIP – VoIP Security Tab 

During the compliance test, SRTP was used internal to the enterprise wherever possible. To view 

or configure the media encryption settings, select the VoIP → VoIP Security tab on the Details 

pane.  

• Set the Media Security drop-down menu to Preferred to have IP Office attempt use 

encrypted RTP for devices that support it and fall back to RTP for devices that do not 

support encryption.  

• Under Media Security Options, select RTP for the Encryptions and Authentication 

fields.  

• Under Crypto Suites, select SRTP_AES_CM_128_SHA1_80.  

• Click OK to commit (not shown). 
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5.3. IP Route 

In the reference configuration, the IP Office LAN2 interface was used to configure the SIP trunk 

to NexVortex, connected via the NexVortex CPE Access Router onsite. Since the Office LAN 2 

interface and the customer facing interface of the NexVortex CPE Access Router were on 

different subnets, an IP route was needed to specify the IP address of the gateway or router 

where the IP Office needed to send the packets, in order to reach the subnet where the 

NexVortex CPE Access Router was located.  

 

To create a new IP route, right-click on IP Route on the left navigation pane. Select New (not 

shown). 

• Under IP Address and IP Mask, enter the network address and subnet mask of the 

customer facing interface of the NexVortex CPE Access Router. This information is to be 

provided by NexVortex. 

• Set Gateway IP Address to the IP Address of the default router in the IP Office subnet. 

• Set Destination to LAN2 from the pull-down menu. 

• Click OK to commit (not shown). 

 

 
 

. 
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5.4. SIP Line 

A SIP Line is needed to establish the SIP connection between IP Office and the NexVortex SIP 

Trunking Service. The recommended method for configuring a SIP Line is to use the template 

associated with these Application Notes. The template is an .xml file that can be used by IP 

Office Manager to create a SIP Line. Follow the steps in Sections 5.4.1 to create the SIP Line 

from the template. 

 

Some items relevant to a specific customer environment are not included in the template or may 

need to be updated after the SIP Line is created. Examples include the following: 

• IP addresses. 

• SIP trunk registration credentials (if applicable). 

• SIP URI entries. 

• Setting of the Use Network Topology Info field on the Transport tab. 

 

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary 

after the SIP Line is created via the template. The resulting SIP Line data can be verified against 

the manual configuration shown in Sections 5.4.2 to 5.4.6. 

 

In addition, the following SIP Line settings are not supported on Basic Edition: 
 

• SIP Line – Originator number for forwarded and twinning calls. 

• Transport – Second Explicit DNS Server. 

• SIP Credentials – Registration Requirement. 

• SIP Advanced Engineering. 

 

Alternatively, a SIP Line can be created manually. To do so, right-click on Line in the 

Navigation pane and select New → SIP Line. Then, follow the steps outlined in Sections 5.4.2 

to 5.4.6. 
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5.4.1. Creating a SIP Line from an XML Template 

Copy the template file to the computer where IP Office Manager is installed. To create the SIP 

Trunk from the template, right-click on Line in the Navigation Pane, then navigate to New 

→New from Template. Select Open from file.  

 

 
 
Navigate to the directory where the template was copied on the local computer and select it. Click 

Open (not shown). 

 

 
 

The new SIP Line is automatically created, and it will appear on the Navigation pane (e.g., SIP 

Line 25). 

 

 
 

It is important that the SIP Line configuration be reviewed and updated if necessary after the SIP 

Line is created via the template. The resulting SIP Line data can be verified against the manual 

configuration shown in Sections 5.4.2 to 5.4.6. 
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5.4.2. SIP Line – SIP Line tab 

On the SIP Line tab in the Details pane, configure or verify the parameters as shown below: 

• ITSP Domain Name: leave as the default (blank) to have IP Office send the ITSP Proxy 

Address as the domain name. See Section 5.4.3. 

• Local Domain Name: Set to the public IP address of the Avaya IP Office LAN2 

interface (e.g., 192.168.80.43).  

• Verify that In Service box is checked, the default value. This makes the trunk available 

to incoming and outgoing calls. 

• Verify that Check OOS box is checked, the default value. IP Office will use the SIP 

OPTIONS method to periodically check the SIP Line. 

• Verify that Refresh Method is set to Auto. 

• Verify that Timer (sec) is set to On Demand. 

• For the compliance test REFER support was disabled. See Section 2.2. Thus, Incoming 

Supervised REFER and Outgoing Supervised Refer should be set to Never.  

• Click OK to commit (not shown). 
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5.4.3. SIP Line - Transport Tab 

Select the Transport tab. Set or verify the parameters as shown below: 

• Set the ITSP Proxy Address to the IP address of the customer facing interface of the 

NexVortex CPE Access Router. This was 172.16.138.171 on the compliance test. 

• Set Layer 4 Protocol to UDP. 

• Set Use Network Topology Info to None (see note below). 

• Set the Send Port and Listening Port to 5060. 

• Default values may be used for all other parameters. 

• Click OK to commit (not shown). 

 

 
 

Note – For the compliance testing, the Use Network Topology Info field was set to None, 

since no NAT was used in the test configuration. If a NAT is used between Avaya IP Office 

and the NexVortex CPE Access Router, then the Use Network Topology Info field should be 

set to the LAN interface (LAN1 or LAN2) used by the trunk and the System → LAN1 (or 2) 

→ Network Topology tab needs to be configured with the details of the NAT device. 
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5.4.4. SIP Line – Call Details tab 

Select the Call Details tab. To add a new SIP URI, click the Add… button. To review an 

existing SIP URI, select it and click the Edit button.  
 

 
 

The SIP URI window will open. Configure the following:  

• Incoming Group: Set to 25 (SIP Line 25). This value references the Line Group ID set 

on the Incoming Call Routes in Section 5.6.  

• Max Sessions: In the reference configuration this was set to 10. This sets the maximum 

number of simultaneous calls that can use the URI before Avaya IP Office returns busy to 

any further calls.  

• Outgoing Group: Set to 25 (SIP Line 25). This will be used for routing outbound calls to 

NexVortex via the ARS configuration (Section 5.8).  

• Check the P-Asserted ID and Diversion Header.  

• For the Local URI, Contact, P Asserted ID and Diversion Header leave the selections 

under the Display and Content columns to the default Auto. With this setting, IP Office 

will use the information on the Incoming Call Routes (Section 5.6) to populate the From 

and Contact headers on outbound calls, and to determine which inbound calls will be 

allowed on the SIP line.  

• On the Field meaning section, set the values under the Outgoing Calls, Forwarding/ 

Twinning and Incoming Calls columns as shown on the screenshot below.  

• Click OK.  
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5.4.5. SIP Line - VoIP tab 

Select the SIP Line → VoIP tab. Set the parameters as shown below: 

• The Codec Selection was configured using the Custom option, allowing an explicit 

order of codecs to be specified for the SIP Line. The buttons allow setting the specific 

order of preference for the codecs to be used on the SIP Line, as shown. During the 

compliance test, the only codec supported by NexVortex was G.711 ULAW. 

• Set Fax Transport Support to None. See Section 2.2. Fax is not supported in this 

solution.  

• Set the DTMF Support field to RFC2833/RFC4733. This directs IP Office to send 

DTMF tones using RTP events messages as defined in RFC2833. 

• Check the Re-invite Supported box. 

• Check the PRACK/100rel Supported box. 

• Default values may be used for all other parameters. 

• Click the OK to commit (not shown). 
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5.4.6. SIP Line – SIP Advanced Tab 

Select the SIP Advanced tab. Set the parameters as shown below:  

• Verify Call Routing Method is set to Request URI. 

• Check the box for Use PAI for Privacy. 

• Default values may be used for all other parameters. 

• Click OK to commit (not shown). 
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5.5. IP Office Line 

In IP Office Server Edition systems, IP Office Lines are automatically created on each server 

when a Secondary server or Expansion System is added to the solution. To edit an existing IP 

Office Line, select Line in the Navigation pane, and select the appropriate line to be configured 

in the Group pane. The screen below shows the IP Office Line to the IP500 V2 Expansion 

System. 

 

 
 

The screen below shows the IP Office Line, VoIP Settings tab. Default values were used for all 

parameters. Note that since fax is not supported in this solution, Fax Transport Support can 

retain the default value of None. 
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5.6. Incoming Call Route 

Incoming call routes map inbound DID numbers on a specific line to internal extensions, hunt 

groups, short codes, etc., within the IP Office system. To add an incoming call route, right click 

on Incoming Call Route in the Navigation pane and select New (not shown).  On the Details 

Pane, under the Standard tab, set the parameters as show below: 

• Set Bearer Capacity to Any Voice.  

• The Line Group ID is set to 25. This matches the Incoming Group field configured in 

the Call Details tab for the SIP Line on Section 5.4.4. 

• On the Incoming Number, enter the DID number for this route. 

When the destination is a user’s extension, the Incoming Number can be used to 

construct the From and Contact headers to be used in place of the extension number in 

the outgoing SIP INVITE for that user. 

• Default values may be used for all other parameters. 

 

 
 

Select the Destinations tab. From the Destination drop-down menu, select the endpoint 

associated with this DID number.  In the reference configuration, NexVortex DID number 

14231231041 was associated with the Avaya IP Office user at extension 6241. 

 

 
 

Repeat this process to route the rest of the NexVortex DID numbers to additional users, as well 

as other Avaya IP Office destinations (Hunt Group, Voicemail, Short Codes, etc.). 
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5.7. Short Code 

Avaya IP Office uses Automatic Route Selection (ARS) to route outbound traffic to the SIP line. 

A short code is needed to send the outbound traffic to the ARS route. To create the short code 

used for ARS, right-click on Short Code in the Navigation Pane and select New (not shown). 

The screen below shows the creation of the short code 9N used in the reference configuration. 

When the Avaya IP Office users dialed 9 plus any number N, calls were directed to Line Group 

65, configurable via ARS and defined next in Section 5.8. 

 

On the Short Code tab in the Details Pane, configure the parameters as shown below.  

• In the Code field, enter the dial string which will trigger this short code, in this case 9N. 

This short code will be invoked when the user dials 9 followed by any number.  

• Set Feature to Dial. This is the action that the short code will perform. 

• Set Telephone Number to N.  The value N represents the number dialed by the user after 

removing the 9 prefix.   

• Set the Line Group ID to the ARS route to be used. In the example shown, the call is 

directed to Line Group 65: NexVortex. 
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5.8. Automatic Route Selection (ARS) 

While detailed coverage of ARS is beyond the scope of these Application Notes, this section  

includes some basic screen illustrations of the ARS settings used during the compliance test. 

 

As described in Section 5.7, Short Code 9N was defined for ARS access. Therefore, outbound 

calls via ARS are dialed as 9 plus the number. ARS will strip off the 9, and it will process the 

call based on the remaining digits.  

 

To add a new ARS route, right-click ARS in the Navigation pane, and select New (not shown).  

The following screen shows the ARS Route ID 65, created in the sample configuration. 
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To add a new ARS table entry, click on the Add button. To change an existing entry, select the 

entry and click on the Edit button.  

 

The example below shows the entry for 11-digit calls. 

 

 
 

• Set Code to 1xxxxxxxxxx  

This means any dialed string starting with a 1, and 11 digits in total will be routed to the 

specified Line Group.  

•  Feature = Dial  

• Telephone Number = 1N  

All 11 digits will be dialed (1+10). 

• Line Group ID = 25 (SIP Line 25).  
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5.9. Outbound Calling Party Information 

According to the SIP URI configuration on Section 5.4.4, Avaya IP Office will use the 

information on the Incoming Number field on the Incoming Call Routes (Section 5.6) to 

populate the From and Contact headers on outbound calls from the IP Office users. These 

headers are used by the service provider to deliver Caller ID information to the receiving end of 

the call. 

 

There are cases where the IP Office user may not be associated with an Incoming Call Route.  

In other situations, it may be desired to send the same outbound caller ID for all the users in the 

enterprise. Short Codes can be created to construct the From and Contact headers in the outgoing 

SIP INVITE message. 

5.9.1. Short Code- User 

In cases where a user does not have an associated Incoming Call Route with a DID number assigned 

to it, a Short Code can be created for that user to set the outbound caller ID.  

 

To set a Short Code for an existing user, select User in the Navigation pane, and select the 

appropriate user to be configured in the Group pane. Select the Short Code tab on the Details pane 

and click Add (not shown). 
 

The following screen shows the Short Codes tab for user 6238. This user does not have an 

associated Incoming Call Route.  

 

 
 

• Set Code to 9N 

• The Telephone Number is set to “Ns4231231000”. The number after the “s” will be 

sent on the From and Contact headers in the outgoing SIP INVITE on calls from this 

user. 

• Feature = Dial 

• Line Group ID = 65, the ARS route to be used for NexVortex. 
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5.9.2. Short Code - ARS 

In some cases, the customer may prefer to send the same outbound caller ID for all the users in 

the enterprise, for example, the published main number for the location.  

 

The Short Code entries on the ARS table (Section 5.8) can be edited, to modify the From and 

Contact headers in the outgoing SIP INVITE messages for all outbound calls.  

 

On the screen below, the entry for 11-digit calls was modified. The Telephone Number is set to 

“1Ns4231231000”. The number after the “s” will be sent on the From and Contact headers in the 

outgoing SIP INVITE on calls from all users in the Avaya IP Office using this ARS route. 
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5.10. Save IP Office Primary Server Configuration 

The provisioning changes made in Avaya IP Office Manager must be applied to the Avaya IP 

Office server in order for the changes to take effect. At the top of the Avaya IP Office Manager 

page, click File → Save Configuration (if that option is grayed out, no changes are pending).  

 

A screen similar to the one below will appear, with either Merge or Immediate automatically 

selected, based on the nature of the configuration changes. The Merge option will save the 

configuration change with no impact to the current system operation. The Immediate option will 

save the configuration and cause the Avaya IP Office server to reboot.  

 

Click OK to execute the save. 
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6. Avaya IP Office Expansion System Configuration 
Navigate to File → Open Configuration (not shown), select the proper Avaya IP Office system 

from the pop-up window, and log in using the appropriate credentials. Clicking the “plus” sign 

next to IP500 Expansion on the left navigation pane will expand the menu on this server. 

 

 

6.1. Physical Hardware 

In the sample configuration, the IP500 V2 Expansion System contained a PHONE8 analog card 

and a COMBO6210 card, for the support of analog and digital stations. Also included is a 

VCM64 (Voice Compression Module). Both the VCM64 and the COMBO6210 cards provide 

voice compression channels to the control unit. Voice compression channels are needed to 

support VoIP calls, including IP extensions and or IP trunks. 
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6.2. LAN Settings 

In the sample configuration, LAN1 is used to connect the Expansion System to the enterprise 

network. To view or configure the LAN1 IP address, select System on the Navigation pane. 

Select the LAN1 → LAN Settings tab on the Details pane, and enter the following:  

• IP Address: 10.5.5.180 was used in the reference configuration.  

• IP Mask: 255.255.255.0 was used in the reference configuration  

• Click the OK button (not shown).  

 

 
 

Defaults were used on the VoIP and Network Topology tabs (not shown). 

6.3. IP Route 

To create an IP route for the Expansion system, right-click on IP Route on the left Navigation 

pane. Select New (not shown). 

• Enter 0.0.0.0 on the IP Address and IP Mask fields to make this the default route. 

• Set Gateway IP Address to the IP Address of the default router in the IP Office subnet. 
The default gateway in the reference configuration was 10.5.5.2 

• Set Destination to LAN1 from the pull-down menu. 
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6.4. IP Office Line 

The IP Office Line was automatically created on each server when the Expansion System is 

added to the solution. Below is the IP Office Line to the Primary server. 

 

 
 

The screen below shows the IP Office Line, VoIP Settings tab. Default values were used for all 

parameters. Note that since fax is not supported in this solution, Fax Transport Support was 

left with the default value of None. The T.38 Fax tab was not visited. 
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6.5. Short Codes 

Similar to the configuration of the Primary server in Section 5.7, create a Short Code to access 

ARS. In the reference configuration, the Line Group ID is set to the ARS route illustrated in the 

next section. 

 

 

6.6. Automatic Route Selection – ARS 

The following screen shows an example ARS configuration for the route named “To-Primary” 

on the Expansion System. The Telephone Number is set to 9N. The Line Group ID is set to 

“99999” matching the number of the Outgoing Group configured on the IP Office Line 17 to 

the Primary server (Section 6.4). 
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6.7. Save IP Office Expansion System Configuration 

Navigate to File → Save Configuration in the menu bar at the top of the screen to save the 

configuration performed in the preceding sections 

 

The following will appear, with either Merge or Immediate selected, based on the nature of the 

configuration changes made since the last save. Note that clicking OK may cause a service 

disruption. Click OK to proceed. 
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7. NexVortex SIP Trunking Service Configuration 
To use the NexVortex SIP Trunking Service, a customer must request the service from 

NexVortex using the established sales processes. The process can be started by contacting 

NexVortex via the corporate web site at https://www.nexvortex.com. 

  

The service provider is responsible for the configuration of the NexVortex SIP Trunking service, 

including the provisioning of the NexVortex CPE Access Router in the customer’s network. 

  

NexVortex will require from the customer the information needed to configure the service, which 

includes: 

• IP address used to reach the Avaya IP Office at the enterprise. In the case of the compliance 

test, this is the public IP address of the IP Office WAN port (LAN2). 

• IP address of the default gateway/router and DNS server used to reach the public network.  

 

NexVortex will provide the customer the necessary information to configure the Avaya IP Office 

SIP trunk connection, including:  

• IP address, protocol and port used to reach the NexVortex CPE Access Router. 

• DID numbers.  

• All IP addresses and port numbers used for signaling or media that will need access to the 

enterprise network through any security devices.  

 

  

https://www.nexvortex.com/


 
MAA; Reviewed: 

SPOC 4/17/2019 

Solution & Interoperability Test Lab Application Notes 

©2019 Avaya Inc. All Rights Reserved. 

 

42 of 46 

NexVortex-IPO11 

 

8. Verification Steps 
This section provides verification steps that may be performed to verify that the solution is 

configured properly. 

 

The following general steps may be used to verify the configuration: 

• Verify that endpoints at the enterprise site can place calls to the PSTN. 

• Verify that endpoints at the enterprise site can receive calls from the PSTN. 

• Verify that users at the PSTN can end active calls to endpoints at the enterprise by 

hanging up. 

• Verify that endpoints at the enterprise can end active calls to PSTN users by hanging up. 

 

Additionally, the Avaya IP Office System Status and Monitor applications are useful tools used 

for the verification of the IP Office configuration and for troubleshooting the SIP connection to 

the service provider. 

8.1. System Status 

The Avaya IP Office System Status application can be used to verify the service state of the SIP 

line. From the IP Office Manager application, select File → Advanced → System Status.  

Under Control Unit IP Address select the IP address of the IP Office system under verification. 

Log in using the appropriate credentials. 
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Select the SIP line from the left pane (Line 25 in the reference configuration). On the Status tab 

in the right pane, verify that the Current State is Idle for each channel (assuming no active calls 

at present time). 

 

 
 

In the lower part of the screen, the Trace All button may be pressed to display real time tracing 

information as calls are made using this SIP Line. The Ping button can be used to ping the other 

end of the SIP trunk. In this case, this is the NexVortex CPE Access Router. 

 

Select the Alarms tab and verify that no alarms are active on the SIP line. 

 

 
 

 

  



 
MAA; Reviewed: 

SPOC 4/17/2019 

Solution & Interoperability Test Lab Application Notes 

©2019 Avaya Inc. All Rights Reserved. 

 

44 of 46 

NexVortex-IPO11 

 

8.2. System Monitor 

The Avaya IP Office Monitor application can be used to monitor and troubleshoot signaling 

messaging on the SIP trunk. Launch the application from Start → Programs → IP Office → 

Monitor on the PC where IP Office Manager was installed. Click the Select Unit icon on the 

taskbar and Select the IP address of the IP Office system under verification.  
 

 
 

Clicking the Trace Options icon on the taskbar and selecting the SIP tab allows modifying the 

threshold used for capturing events, types of packets to be captured, filters, etc. Additionally, the 

color used to represent the packets in the trace can be customized by right clicking on the type of 

packet and selecting to the desired color. 
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9. Conclusion 
These Application Notes describe the procedures required to configure Avaya IP Office Release 

11 to connect to the NexVortex SIP Trunking service, as shown in Figure 1.  

 

Interoperability testing of the sample configuration was completed with successful results for all 

test cases with the observations/limitations described in Sections 2.1 and 2.2. 

10. Additional References  
This section references the documentation relevant to these Application Notes. Product 

documentation for Avaya IP Office, including the following, is available at: 

http://support.avaya.com/ 

 

[1] Deploying IP Office Platform Server Edition Solution, Release 11.0, May 2018 

[2] IP Office Platform 11.0, Deploying Avaya IP Office Servers as Virtual Machines, January 

2019 

[3] IP Office Platform 11.0, Deploying Avaya IP Office Essential Edition (IP500 V2), February 

2019. 

[4] Administering Avaya IP Office Platform with Manager, Release 11.0 FP4, February 2019. 

[5] Administering Avaya IP Office™ Platform with Web Manager, Release 11.0 FP4, February 

2019. 

[6] Planning for and Administering Avaya Equinox for Android, iOS, Mac and Windows, 

Release 3.4.8, November 2018 

[7] Using Avaya Equinox for IP Office, Release 11.0 FP4, February 2019 

 

Additional Avaya IP Office information can be found at:  

http://marketingtools.avaya.com/knowledgebase/  

 

 

  

http://support.avaya.com/
http://marketingtools.avaya.com/knowledgebase/
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